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Abstract

In 2019, researchers have successfully discovered thousands of ancient artefacts at
the Bongal Site. The ancient artefacts found were identified as originating from
India, China, and the Middle East. This research aims to describe how the process
of developing historical tourism at the Bongal International Site using Augmented
Reality (AR) and Virtual Reality (VR) technology. The research method employed
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led to the creation of a prototype for historical tourism at the Bongal International
Accepted: Site, utilising Augmented Reality and Virtual Reality technology. Artefacts that

June 16, 2025 have been successfully created using AR/VR technology include Umayyah coins,

Abbasid coins, cups, mini statues, and Amoghapasa statues. This research also
succeeded in creating a 3600 Virtual Tour application. The creation of AR/VR
applications for the Bongal International Site is expected to enhance the site's
landscape, making it more enjoyable and memorable for tourists.
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Introduction

Tourism contributes significantly to economic growth and is one of the factors
supporting a country’s prosperity (Thommandru et al., 2023). Tourism has a positive
impact on the country's economic growth, ranging from the channelling of capital,
goods, and technology, to encouraging the progress of knowledge dissemination and
research development, as well as promoting regional development (Brida et al., 2020;
Calero & Turner, 2020). The growth of tourism is expected to have a positive impact
on job creation, increase income, foster economic prosperity, and generate foreign
exchange reserves (Bazargani & Kilig, 2021, Thommandru et al., 2023). Other
contributions that the tourism sector can make to the country are improving people's
welfare, alleviating poverty, developing infrastructure, and conserving nature. All of
these impacts are important not only for the present but also for the future (sustainable
development) (Serensen & Grindsted, 2021). In Indonesia, tourism contributes
significantly to economic growth, as evidenced by the increase in foreign exchange
earnings, regional income, and development, as well as increased national and foreign
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investment, a higher flow of goods and technology, employment opportunities, and
business development (Pariwisata, 2021).

Tourism in Indonesia is currently emerging as one of the leading sectors
supporting the country's economic growth. Increasing foreign exchange and regional
income, as well as regional development, investment, employment, and business
growth spread across various regions of Indonesia, is a form of tourism's contribution
to Indonesia's economic development. By 2027, Indonesia’s Gross Domestic Product
(GDP) from tourism is expected to amount to 5.6% (Oktadiana, 2021). This number
increased significantly in 2022 to 19.82% of the country’s tourism revenue (Johanes et
al., 2024).

Heritage tourism and historical tourism are the most popular and fastest growing
types of tourism among global travellers (Zhu, 2021), because this type of tourism
offers unique and unforgettable experiences (Arumugam et al., 2023). Global tourists
do not just want to have fun or rest and relax; they also seek something new that
provides an experience world citizens, mobilizes destination residents as fellow
citizens (Kemenparekraf, 2022). These efforts are expected to create resilient and
sustainable mass tourism (Weaver et al., 2021). In addition, today’s travellers are
capable of becoming producers and have the technical tools to reconstruct their travel
experiences. Travel experience, travel enjoyment, and travel satisfaction are key factors
in today’s travel trends (Pai et al., 2021).

The Bongal site is an area rich in world historical heritage, where in 2019, a 'lost
ancient port city' was discovered at the site. The Bongal site is located on the coast of
Tapanuli Bay, precisely in Jago-jago Village, Badiri Sub-district, Central Tapanuli
Regency, North Sumatra Province. Bongal is the name of a hill 324 metres above sea
level (Amelia et al., 2024). It is approximately 60 kilometres south of Barus, with
coordinates: 01°35’30.9”N, 98°49'42.1”"E (Soedewo et al., 2025). The three great
civilizations of the world, namely the Middle East, India, and China are brought
together at this site, as evidenced by the discovery of millions of artifact fragments
such as Umayyad Dynasty and Abbasid Dynasty coins, 7th-century Persian jars, Tang
Dynasty Chinese ceramics, statues, ancient Islamic medical equipment, inscribed
manuscripts and wooden boards, ancient Chinese coins, shipwrecks, pottery, beads
and various other artifacts that number in the thousands (Azhari, 2021; Soedewo,
2021). The Bongal International Site boasts a very charming landscape, featuring a
stretch of coastline and hills, which further enhances the attractiveness of the region to
both local and international tourists (Azhari et al., 2020).

The enormous potential of historical and natural tourism at the Bongal Site will
undoubtedly be highly beneficial for the economic growth of local and national
communities. The involvement of the Bongal Site in the ancient spice route network,
as evidenced by the discovery of various artefacts, represents a valuable historical
tourism asset. This site can be developed into a ‘world-class historical tourist
destination” that can attract both domestic and international tourists to visit. The
development of historical tourism at the Bongal Site in line with the government’s
efforts to realize the Spice Route of the Indonesian Archipelago as a UNESCO World
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Cultural Heritage site (Wapresri.go.id, 2024).

Amid the massive development of technology and the digital world today, one
effort that can be made to develop the historical tourism potential of the Bongal
International Site is through virtual technology. This technology is accessible through
Android, iOS, or PC, providing visitors with a unique and memorable experience.
Augmented Reality (AR) and Virtual Reality (VR) are currently the most widely used
virtual technologies in tourism development, aiming to attract tourists. AR and VR
offer a highly interactive experience that combines the natural and virtual worlds
(Wedel et al.,, 2020; Verma et al., 2022). Through Android-based mobile phones,
tourists can easily use AR and VR applications while visiting destinations. Virtual
reality (VR) makes it easy to access distant tourist destinations. Tourists can enjoy the
tourist experience without having to visit the tourist location (Atzeni et al., 2022) and
prepare a large amount of money for travelling costs (Siddiqui et al., 2022).

Augmented Reality (AR) is a technology that focuses on modifying the
perception of real-world images and adding a layer of digital data on top of them
(Dargan et al.,, 2023). Overlaying digital objects on top of real-world images can
enhance functionality and provide additional information that can enrich the content
of the object (Al-Ansi et al., 2023). Augmented Reality (AR) utilises synthetic images
(virtual objects) to overlay them on real images, thereby projecting virtual objects as
part of the real world (Wedel et al., 2020; Verma et al., 2022). Additionally, AR
technology can also augment or replace real objects with virtual ones (Verma et al.,
2022). AR is used on smartphone devices through applications or social media by
relying on camera sensitivity (Octaviani, 2023).

For historical tourism that showcases artefacts, historical objects, and cultural
heritage, the use of Augmented Reality can expand the number of collections and
complement artefacts that cannot be displayed offline. In addition, the use of AR
during the visit can also facilitate the provision of additional information about
artefacts that have limited textual narratives (Chen et al., 2024) and animations that
make them more attractive and memorable (Boboc et al., 2022).

Virtual reality is a computer-generated three-dimensional virtual environment
that users can interact with through a head-mounted device and sensors (Hamad &
Jia, 2022). AR will be more optimal when combined with Virtual Reality (VR)
applications, where tourists can experience virtual tourism through 3D presentations
and create virtual space (Daassi & Debbabi, 2021). VR focuses on the total immersive
experience, whereas AR involves interaction between the user, digital content, and the
real world (Xiong et al., 2021). AR technology is spatial, while VR is 3D. VR
distinguishes between real and virtual illusions, while AR displays virtual images in
the real world. The use of AR and VR applications engages multiple human senses,
including sight, hearing (or sound), touch, and smell, to provide visitors with an
immersive experience (Fan et al., 2022).

The use of AR and VR can enable visitors to enjoy a more attractive, enjoyable
and memorable experience (Boboc et al., 2022). AR and VR also and contribute
positively to expanding promotion through websites and social media platforms
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(Chen et al., 2024). Tourists can easily enjoy various historical tourist attractions online
using their smartphones or PCs without having to visit the area. The use of AR and
VR also has a positive impact on the preservation of historical artefacts, as it reduces
physical contact that can damage sites (Karaman & Deniz, 2025). Based on these
factors, AR and VR technology are well-suited for application at the Bongal
International Site, which is rich in various relics of Indonesian history dating back to
the early centuries AD. This research aims to describe how the process of developing
historical tourism at the Bongal International Site using Augmented Reality (AR) and
Virtual Reality (VR) technology.

Method

The method used in this research is the Research and Development (R&D) method,
which aims to develop new products, processes, or services (Kainulainen, 2023). The
stages used for prototyping consist of three stages: pre-production, production, and
post-production. The pre-production stages include potential problem analysis, data
collection, 3D object design, and planning. To analyse potential problems,
observations and interviews were conducted to assess the potential of historical
tourism at the Bongal International Site, which will be developed for AR and VR
applications. In analysing the potential problems, the proposing team also conducted
a literature review to strengthen the research hypothesis and inform the design process
of the AR and VR-based Bongal Site History Tourism prototype. After the problem
was identified, the next step was to collect data on the artifacts and landscapes of the
Bongal Site through photos and videos. These data will be input into the 3D object
design plan. The production stage involves manufacturing for 3D object modelling.
The post-production stage involves encoding 3D elements so that they can be
displayed during the scanning process. The end of the post-production stage involves
creating the Unity application format and establishing the thesis website link for
testing.

There are several stages in designing Augmented Reality (AR) artifacts for the
Bongal International Site. These stages are preparation (Install Unity 3D and Vuforia
Apk then create an account), Create New Project (creating 3D artifacts on Unity Apk),
Project Configuration, Vuforia Activation, AR Target Import, Creating AR Objects,
Object Configuration, Creating Scripts for AR Interaction, AR Project Test, and AR
App Optimization and Distribution. In addition, there are three stages in designing a
Virtual Reality (VR) link to the Bongal International website, which are 360° Image
Capture (using Street View app), creation of a 360° Virtual Tour (using Theasys.io
website), and Virtual Reality (VR) Testing.

Potential of Bongal Site as a Historical Tourism Destination in North Sumatra

The discovery of the Bongal Site in 2019 benefits historical tourism in Central Tapanuli
Regency. The discovery of thousands of historical artifacts found by residents or the
result of excavations by archaeologists and historical research, can unlock new
historical tourism potential in Central Tapanuli. The Bongal site has the potential to be
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developed into a world-class historical tourism destination. This tourism potential
contributes positively to historic preservation efforts at this site. It is also expected to
have a positive impact on the economies of the surrounding communities as well as
those of North Sumatra and Indonesia.

The Bongal site played a crucial role as an ancient port city in the Nusantara Spice
Route trade network during the early centuries AD. The three great civilisations of the
world —namely, the Middle East, India, and China—are brought together at this site.
This fact is supported by the discovery of various artifacts from the three world
civilisations at the Bongal Site. This factor made the discovery of the Bongal Site in
2019 so shocking to the world of history and antiquities. Excavations carried out since
2021 have yielded millions of artifacts of international standard at the Bongal Site.

Based on the results of research and excavation, the Bongal Site is the only site in
the archipelago that contains the oldest evidence of interaction between Sumatra
Island and the region of Islamic origin (Middle East). These facts have the potential to
offer a new perspective on the history of Islam’s entry into Indonesia. The artifacts
found at the Bongal Site include: 1) The ancient Dinar and Dirham currency of the
Ummayah and Abbashah Dynasties' leaders, dating from the 7th to 9th centuries AD.
These coins include coins of the Umayyad Dynasty dated 75-95 AH (694-713 AD);
Abbasid Dynasty (Caliph Abdullah Al-Mansyur) coins dated 143 AH (760 AD), 147
AH (764 AD), 149 AH (766-767 AD), 154 AH (771 AD); coin of the Abbasid Dynasty
(Caliph Muhammad Al-Mahdi) dated 166 AH (782 AD); The coin of the Abbasid
Dynasty (Caliph Muhammad Al-Amin) is dated 195 AH (810-811 AD); Abbasid
Dynasty (Caliph Al-Ma'mun) coin dated 204 AH (819-820 AD) (Azhari, 2021; Soedewo,
2021; Arrumdani et al., 2022).

The next artefact found at the Bongal Sites was Ukkiyah. Ukkiyah is the Middle
Eastern unit of measurement for dinars and dirhams. It was an ancient financial
institution that controlled the monetary system in this lost city. Other artefacts are
Neyshabur urn from Persia/Iran (VII-IX century AD); Alembic (distillation device);
Ancient Islamic medical equipment; A teapot or kettle made of glass from the Middle
East, X-XI century AD; Serahi (small bottle) was made in Syria or Egypt in the X-XI
century AD; Ganesha figurines, Pandya coins, and ancient Indian jewellery; Wooden
board inscribed with Pallawa script, VII-VIII century AD; Tin sheets are written in
post-Pallawa (Old Sumatran) script and Old Malay and Sanskrit from the 8th-IXth
centuries AD; Tang Dynasty ceramic bowl, 8th-Xth century AD; Ancient Chinese
coins; Copper weights (dacin); Ancient ship body fragments and dhouw; A wooden
structure thought to have served as a dwelling or dock; Various types of artifacts are
made of pottery, ceramics, stone, wood, and metal (gold, silver, tin, copper, and
bronze) (Azhari, 2021; Soedewo, 2021).

The richness of historical narratives and cultural heritage associated with the
Bongal Site in the World Spice Route network is a precious asset in Indonesian tourism.
This potential can be developed into a 'world-class historical tourism destination' that
attracts national and international tourists to visit this site. This effort aligns with the
Ministry of Tourism and Creative Economy’s program, which aims to revive the Spice
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Route, once the pride of Indonesia, and to realise the Archipelago Spice Route as a
UNESCO World Cultural Heritage by 2024/2025. Indonesia Spice Up the World
(ISUTW), which runs until 2024, is one of the Spice Route tourism activities organized
by the Ministry of Tourism and Creative Economy (Henry, 2024).

The tourism potential of the Bongal Site is also closely related to the 2018-2028
Regional Tourism Development Master Plan of Central Tapanuli Regency, which aims
to make Central Tapanuli a world-class cultural tourism destination in Indonesia
(Peraturan Daerah Tapanuli Tengah No. 9, 2009). This effort is expected to contribute
positively to the preservation of history at this site and to encourage regional
development that can have a positive impact on the economies of the surrounding
communities, as well as North Sumatra and Indonesia.

Development of Augmented Reality (AR) and Virtual Reality (VR) based Historical
Tourism at Bongal Site

Development of Augmented Reality (AR) Prototype through Unity application
Bongal Site

In developing AR applications, device specifications are required. Hardware used in
the development of Prototype AR: ASUS laptop type ROG Strix, processor Inter Core
i7, memory 16 gigabyte, hard drive 3 terabyte, graphic card RTX 2060 6 GB. Hardware
used in AR Prototype testing: All types of laptops and cell phones can be used in
testing if they are connected to the internet. Next are the steps for creating and using
Augmented Reality, such as (1) Photographs of artifacts taken directly at the Bongal
International Site, Jago-Jago Village; (2) Download and install Unity 3D from the
official Unity website. Create a Vuforia account on the Vuforia Developer Portal site
(https://developer.vuforia.com). Download the Vuforia SDK and corresponding
license from the Vuforia Developer Portal; (3) Open Unity and create a new project by
selecting "File" > "New Project". Select an appropriate template, such as "3D". Once the
project is open, ensure that you import the Vuforia package into the project. To do this,
go to the "Assets" menu > "Import Package" > "Custom Package", then search and select
the Vuforia package that you have downloaded; (4) Inside the Unity project, go to
"Edit" > "Project Settings" > "Player”. In the "More Settings" tab, change the "Script
Runtime Version" to "Equivalent”. NET 4.x". In the "XR Settings" tab, enable "Vuforia
Augmented Reality Supported”; (5) Inside the Unity project, go to "Window" >
"Vuforia Configuration". Click "Add License Key" and enter the Vuforia license
obtained from the Vuforia Developer Portal. Enable "Digital Glasses" if developing a
dedicated AR device such as HoloLens or Magic Leap; (6) Download AR targets from
the Vuforia Developer Portal. These can be image targets or physical objects. Import
the AR target into the Unity project by right-clicking inside the Asset, and selecting
"Import Package" > "Custom Package," and then selecting the downloaded AR target
tile; (7) Create or import 3D objects that you want to display when an AR target is
detected. Make sure the objects are in the correct hierarchy. Usually, it places the object
as a child of the AR target, so the object appears when the target is detected; (8) AR
Camera: Add the "AR Camera" component to the object hierarchy. Inside the Inspector,
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set the camera mode to "Device" so that the device camera is used for AR. In the "Data
Set Loading Behavior" section, add a data set containing the imported AR targets; (9)
Create a C# script that will control the interaction of AR objects when a target is
detected. You can use methods such as OnTrackingFound() and OnTrackingLost() to
control the behaviour of objects when a target is detected or lost; (10) Connect an AR-
enabled physical device to your computer or use an AR emulator if available. Run the
project in Unity and point the device camera at the AR target. You should be able to
see AR objects appear when a target is detected; (11) During development, ensure the
project is optimised for optimal performance and user experience. Once you have
tinished developing your AR project, you can distribute it to target platforms, such as
IOS, Android, or others, as needed. Follow the platform distribution guidelines that
are appropriate for the platform you are targeting. Here are the steps to create and use
Augmented Reality.

A =

S e

Figure 1. Photo of the excavation site of the ol mine at the Bongal Site.

Figure 2. Artifact photos that have been used in making AR-VR applications.
After creating the application, a trial is required. The steps include: Open the

Bongal Site Unity application, then point the lens at the QR code. The following are
the results of the AR test of the artifacts found at the Bongal International Site:
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Hoin lbbasiyah

QR Scan Result
using google lens

Figure 3. Display of Ummayah and Abbasid Coins in the application that has been
made.

Based on the picture above, if you scan the QR listed through Google Lens, the
desktop or mobile screen will switch to AR, which contains a 3D display of Ummayah
and Abbasid coins. The coins can be seen, with a circular movement (both the front
and the back are visible), indicating no failures in the AR trial.

Figure 4. Display of Cepu Artifacts in the application that has been made.

Based on the picture above, if you scan the image listed through the Vuforia
application, the desktop or mobile screen display will switch to AR, which contains a
3D display of the cepu coin. The cepu can be seen, with a circular movement (both the
front and the back are visible), so that nothing fails in the AR trial.

N

Figure 5. Display of Mini Statue Artifacts in the application that has been created.

Based on the picture above, if you scan the QR code listed through Google Lens,
the desktop or mobile screen display in the Instagram application will switch to AR,
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featuring a 3D display of mini statue artifacts. The mini statue can be seen clearly, with
a circular movement (the front and the back are visible), so there is no failure in the
AR trial.

Figure 6. Display of Amoghapasa Artifacts in the application that has been created.

Based on the picture above, if you scan the QR code listed through Google Lens,
the desktop or mobile screen display in the Instagram application will switch to AR,
which contains a 3D display of amoghapasa artifacts. The amoghapasa can be seen
clearly, with a circular movement (both the front and the back are visible), so there is
no failure in the AR test.

Figure 7. Field Data Collection Process in ]ao-jago Village.

Virtual Reality (VR) Prototype Development through Theasys Website application

The Virtual Reality (VR) environment comprises two primary locations: the Bongal
International Site and the Fansuri Museum, alongside several artifacts equipped with
QR codes. The hardware specifications necessary for the development of the VR
prototype include a computer or laptop with internet connectivity, with all types of
laptops suitable for VR creation. For testing the VR prototype, the hardware utilized
was an iPhone, model 7 with 128 GB storage, operating on iOS 15.7.8, featuring an
IMEI of 35 532608 106001 4, a 12 MP camera, a six-core graphics GPU, Wi-Fi 802.11
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a/b/g/n/ac, Dual Band, and Mobile Hotspot capabilities. The 360° virtual tour image
capture was conducted in person by researchers at Jago-Jago Village, located within
the Bongal International Site. The 360° image capture process employs the Street View
application, which involves capturing a comprehensive view of the wuser's
surroundings. This method produces images that are more complete than those
produced by traditional photography. The procedure includes opening the Street View
app, selecting 'Create,’ pressing the camera icon, taking a series of photos, and then
selecting 'Done' to merge and store the 360° photos as "Private."

Creating a 360° Virtual Tour can be done in various ways. The first way is to
create online through the web, such as theasys.io and other service providers. The
second way is to create a 360° virtual tour using 3D Vista software and similar tools.
Steps to create a virtual tour in Theasys include: First, sign up for an account and
activate it. Next, upload 360-degree panoramic photos, ensuring they are named
systematically for easier management. Then, link the 360-degree photos together.
Configure the look and functionality of the virtual tour. Install and activate the
necessary plugins. Request an API token and install it in the Theasys plugin. Finally,
input the short URL of the completed virtual tour.

Virtual Reality/VR Trial
Some artifact links that have been VR-ized have been loaded in the form of QR (Quick
Response). The results of the Virtual Tour trial are as follows.

Situs Bongal

The Bongal website has a link: https://ths.li/z7uRdKEV. Based on the Figure 8. above, if
you click on the link listed, the desktop or mobile screen display will switch to theasys
website on the way to the Bongal International Site. The interactive buttons appear and
function correctly, and the view can be seen in 360 degrees, indicating no failure in the
link test.

Figure 8. Jago-jago illage view in the applicatioh that has been created.
Fansuri Museum

The Fansuri Museum website has a link: https://ths.li/S5ncwr4. Based on the Figure 9.
above, if you click on the link listed, the desktop or mobile screen will switch to theasys
website at Fansuri Museum. The interactive buttons appear and function correctly,
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and the view can be seen in 360 degrees, so there is no failure in the link test.

Figure 10. QR code for testing the AR-VR application at the Bongal Site gold mine.

If you scan the QR code from Figure 10. listed through Google Lens, the desktop or
mobile screen will switch to Google Drive, which contains a short video about ancient
glass flakes. Interactive buttons appear and function correctly, and a slide-shaped view
is in full view, so that nothing fails in the QR trial.

Ancient 8th Century Glass Flakes

If you scan the QR code from Figure 11. listed through Google Lens, the desktop or
mobile screen will switch to Google Drive, which contains a short video about ancient
glass flakes. Interactive buttons appear and function correctly, and a slide-shaped view
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is in full view, so that nothing fails in the QR trial.

Figure 11. QR code for AR-VR Application Trial at Bongal Site

Conclusion

The Bongal site is an ancient port city located on the Nusantara Spice Route, a trade
network that united three major world civilisations: the Middle East, India, and China.
This fact is evidenced by the discovery of millions of artifacts from these three great
civilisations in the Bongal Site area. The discovery of these artifacts also confirms
Bongal's position as a world-class International Site with very high historical tourism
potential.

Technological advances in modern times provide numerous benefits, including
the ability to be felt directly, as exemplified by the development of historical tourism
at the Bongal International Site, which utilises Augmented Reality and Virtual Reality
technology. The development of Bongal International Site History tourism with AR
and VR models is expected to provide tourists with an accurate picture. Through this
AR/VR-based application, tourists can learn about and discover the Bongal
International Site, a historical site rich in world historical heritage. The creation of AR
and VR prototypes for the Bongal International Site is expected to futher develop the
site landscape, allowing tourists to experience more immersive sensations, such as
being in the actual location of the site.

Referrences

Al-Ansi, A. M., Jaboob, M., Garad, A., & Al-Ansi, A. (2023). Analyzing augmented
reality (AR) and virtual reality (VR) recent development in education. Social
Sciences and Humanities Open, 8(1), 100532.
https://doi.org/10.1016/j.ssah0.2023.100532.

Amelia, P., Azhari, I., & Purnamasari, 1. (2024). Artefacts evidence of the entry of Islam in
the first history century (7th A.D.) at the Bongal Site, Badiri District, Central
Tapanuli District. March. https://doi.org/10.4108/eai.24-10-2023.2342343

Arrumdani, N., Asari, H., & Yasmin, N. (2022). Kontribusi koin Umayyah temuan
Situs Bongal terhadap historiografi Islam di Sumatera Utara. Yupa: Historical
Studies Journal, 6(2), 125-148. https://doi.org/10.30872/yupa.v6i2.1504.

Arumugam, A., Nakkeeran, S., & Subramaniam, R. (2023). Exploring the factors

influencing heritage tourism development: A model development. Sustainability
(Switzerland), 15(15), 1-18. https://doi.org/10.3390/su151511986.

Development of Historical Tourism Based on Augmented Reality (AR) and Virtual Reality (VR) |39



IHiS (Indonesian Historical Studies) 9 (1), 28-42 © 2025 | E-ISSN: 2579-4213

Atzeni, M., Del Chiappa, G., & Mei Pung, J. (2022). Enhancing visit intention in
heritage tourism: The role of object-based and existential authenticity in non-
immersive virtual reality heritage experiences. International Journal of Tourism
Research, 24(2), 240-255. https://doi.org/10.1002/jtr.2497.

Azhari, I. (2021). Islam masuk ke Indonesia sejak abad pertama Hijriyah. Waspada.

Azhari, L, Sihite, O., & Daud. (2020). Pemetaan dan identifikasi potensi pariwisata di
Kecamatan Badiri Kabupaten Tapanuli Tengah. Virtual Seminar Nasional Hasil
Pengabdian Kepada Masyarakat LPPM UNIMED, November, 206-211.

Bazargani, R. H. Z., & Kilig, H. (2021). Tourism competitiveness and tourism sector
performance: Empirical insights from new data. Journal of Hospitality and Tourism
Management, 46, 73-82. https://doi.org/https://doi.org/10.1016/j.jhtm.2020.11.011.

Boboc, R. G., Bautu, E., Girbacia, F., Popovici, N., & Popovici, D. M. (2022). Augmented
reality in cultural heritage: An overview of the last decade of applications. Applied
Sciences (Switzerland), 12(19). https://doi.org/10.3390/app12199859.

Brida, J. G., Matesanz Gomez, D., & Segarra, V. (2020). On the empirical relationship
between tourism and economic growth. Tourism Management, 81(May).
https://doi.org/https://doi.org/10.1016/j.tourman.2020.104131.

Calero, C., & Turner, L. W. (2020). Regional economic development and tourism: A

literature review to highlight future directions for regional tourism research.
Tourism Economics, 26(1), 3-26. https://doi.org/10.1177/1354816619881244.

Chen, Y., Wang, X., Le, B.,, & Wang, L. (2024). Why people use augmented reality in
heritage museums: a socio-technical perspective. Heritage Science, 12(1), 1-19.
https://doi.org/10.1186/s40494-024-01217-1.

Daassi, M., & Debbabi, S. (2021). Intention to reuse AR-based apps: The combined role
of the sense of immersion, product presence and perceived realism. Information
and Management, 58(4). https://doi.org/10.1016/j.im.2021.103453.

Dargan, S., Bansal, S., Kumar, M., Mittal, A., & Kumar, K. (2023). Augmented reality:
A comprehensive review. Archives of Computational Methods in Engineering,
30(March 2023), 1057-1080. https://doi.org/https://doi.org/10.1007/s11831-022-
09831-7.

Fan, X, Jiang, X., & Deng, N. (2022). Immersive technology: A meta-analysis of

augmented/virtual reality applications and their impact on tourism experience.
Tourism Management, 91.
https://doi.org/https://doi.org/10.1016/j.tourman.2022.104534.

Hamad, A., & Jia, B. (2022). How virtual reality technology has changed our lives: An
overview of the current and potential applications and limitations. International
Journal ~ of  Environmental = Research  and  Public ~ Health,  19(18).
https://doi.org/10.3390/ijerph191811278.

Henry. (2024). Apa Kabar Program  Indonesia  Spice Up the World?
https://www.liputan6.com/lifestyle/read/5509536/apa-kabar-program-
indonesia-spice-up-the-world?page=4.

Development of Historical Tourism Based on Augmented Reality (AR) and Virtual Reality (VR) |40



IHiS (Indonesian Historical Studies) 9 (1), 28-42 © 2025 | E-ISSN: 2579-4213

Johanes, R., Takari, D., & Sabirin, S. (2024). Review of the tourist industry’s role in
Indonesia’s GDP growth. Journal Magister Ilmu Ekonomi Universtas Palangka Raya :
GROWTH, 10(1), 8-17. https://doi.org/10.52300/grow.v10i1.15151.

Kainulainen, S. (2023). Research and development (R&D). In M. F (Ed.), Encyclopedia of
Quality of Life and Well-Being Research. Springer.
https://doi.org/https://doi.org/10.1007/978-3-031-17299-1 2482.

Karaman, M. K., & Deniz, O. (2025). The role of VR, AR, and Artificial Intelligence in
the sustainable preservation of cultural heritage: social media marketing of

historical sites, new media education in Turkey, and their contributions to SDGs.

5,1-22.
Kemenparekraf. (2022). Siaran Pers: Menparekraf: Sejarah Jadi Salah Satu Tema Wisata
Paling Diminati Wisatawan Pascapandemi.

https://kemenparekraf.go.id/berita/siaran-pers-menparekraf-sejarah-jadi-salah-

satu-tema-wisata-paling-diminati-wisatawan-pascapandemi.

Octaviani, A. W. (2023). Pemanfaatan augmented reality sebagai media pengenalan
mata uang Indonesia kepada turis asing berbasis smartphone. JIIP - Jurnal llmiah
llmu Pendidikan, 6(3), 2138-2145. https://doi.org/10.54371/jiip.v6i3.1911.

Oktadiana, H. (2021). No Title. In A Potrait of Indonesia Tourism: Present and Future (pp.
255-272). Apple Academic Press.

Pai, C., Kang, S., Liu, Y., & Zheng, Y. (2021). An examination of revisit intention based
on perceived smart tourism technology experience. Sustainability (Switzerland),
13(2), 1-14. https://doi.org/10.3390/su13021007.

Pariwisata, K. (2021). Strategi Promosi Wisata Budaya. Kementerian Pariwisata RI.

Peraturan Daerah Tapanuli Tengah No. 9 (2009).

Siddiqui, M. S., Syed, T. A., Nadeem, A., Nawaz, W., & Alkhodre, A. (2022). Virtual
tourism and digital heritage: An analysis of VR/AR technologies and
applications. International Journal of Advanced Computer Science and Applications,
13(7), 303-315. https://doi.org/10.14569/IJACSA.2022.0130739.

Soedewo, E. (2021). Jago-jago, situs pelabuhan tertua di pantai barat Sumatera Utara.
Presented in FGD Islam Dan Jalur Rempah Universitas Islam Negeri Sumatera Utara.

Soedewo, E., Bakar, A., Purnawibowo, S., Setiawan, T., Satria, D., Anas, A., Sofian, O.,
Hendrawan, M. F., Tobing, L. R. L., Oetomo, R. W., & Adhityatama, S. (2025).
History of the west coast of North Sumatra before Barus: Preliminary results of
archaeological research at the Bongal settlement site History of the west coast of North
Sumatra before Barus: Preliminary results of archaeological research at the Bongal s
(Issue January). https://doi.org/10.4000/12fvk.

Serensen, F., & Grindsted, T. S. (2021). Sustainability approaches and nature tourism
development. Annals of Tourism Research, 91.
https://doi.org/https://doi.org/10.1016/j.annals.2021.103307.

Thommandru, A., Espinoza-Maguifia, M., Ramirez-Asis, E., Ray, S., Naved, M., &
Guzman-Avalos, M. (2023). Role of tourism and hospitality business in economic
development. Materials Today, 80(3), 2901-2904.
https://doi.org/https://doi.org/10.1016/j.matpr.2021.07.059.

Development of Historical Tourism Based on Augmented Reality (AR) and Virtual Reality (VR) |41



IHiS (Indonesian Historical Studies) 9 (1), 28-42 © 2025 | E-ISSN: 2579-4213

Verma, S., Warrier, L., Bolia, B., & Mehta, S. (2022). Past, present, and future of virtual
tourism-a literature review. International Journal of Information Management Data
Insights, 2(2). https://doi.org/10.1016/j.jjimei.2022.100085.

Wapresri.go.id. (2024). Perkaya Bahan dan Data pada Pengajuan Jalur Rempah sebagai
Warisan Dunia UNESCO, Setwapres Gelar Diskusi Terbatas.
https://www.wapresri.go.id/perkaya-bahan-dan-data-pada-pengajuan-jalur-
rempah-sebagai-warisan-dunia-unesco-setwapres-gelar-diskusi-terbatas/.

Weaver, D. B., Moyle, B., & McLennan, C.]J. (2021). The citizen within: positioning local
residents for sustainable tourism. Journal of Sustainable Tourism, 30(4), 897-914.
https://doi.org/https://doi.org/10.1080/09669582.2021.1903017.

Wedel, M., Bigné, E., & Zhang, J. (2020). Virtual and augmented reality: Advancing
research in consumer marketing. International Journal of Research in Marketing,
37(3), 443-465. https://doi.org/10.1016/j.ijresmar.2020.04.004.

Xiong, J., Hsiang, E. L., He, Z., Zhan, T., & Wu, S. T. (2021). Augmented reality and
virtual reality displays: emerging technologies and future perspectives. Light:
Science and Applications, 10(1), 1-30. https://doi.org/10.1038/s41377-021-00658-8.

Zhu, Y. (2021). Heritage tourism: From problems to possibilities. Cambridge University
Press. https://doi.org/https://doi.org/10.1017/9781108914024.

Development of Historical Tourism Based on Augmented Reality (AR) and Virtual Reality (VR) |42



